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Using TNTatlas

Before Getting Started
TNTatlas® is a free product available from MicroImages for viewing hierarchical
atlases prepared in TNTmips® with HyperIndex® Linker or for single layout
atlases.  You can also view single files in any of the many formats supported for
direct use by the TNT products.  TNTatlas, like the other TNT products, runs
with MicroImages X Server (MI/X) with Windows and X11 from XQuartz on the
Mac.  TNTatlas largely uses TNTmips’ Display code; many of the changes made
in Display automatically appear in TNTatlas.

Prerequisite Skills  This booklet assumes you have completed the exercises in
Displaying Geospatial Data and TNT Product Concepts.  Those exercises intro-
duce essential skills and basic techniques that are not covered again here.  Please
consult these booklets for any review you need.

Sample Data  The exercises in this booklet use sample data distributed with the
TNT products.  If you do not have access to a TNT products DVD, you can
download the data from MicroImages’ web site. The exercises in this booklet use
the Project Files in the TNTATLAS directory of DATA and the TNTatlas file (.atl) also
found there.  A read-write copy of sample data on your hard drive is not required
since atlases can be run with the data on DVD.  Making a copy on your hard drive
will generally speed access, however.

More Documentation  This booklet is intended only as an introduction to using
TNTatlas.  There are additional booklets that discuss the design (Designing
Electronic Atlases) and construction (Constructing an Electronic Atlas) of
TNTatlases that you may wish to consult.

TNTmips Pro, TNTmips Basic, and TNTmips Free  TNTmips comes in three
versions: TNTmips Pro, TNTmips Basic, and TNTmips Free.  If you did not
purchase the professional version (which requires a software license key), you
are using TNTmips Free or TNTmips Basic, which limit the size of your project
materials.  All exercises in this booklet can be completed in TNTmips Free using
the sample geodata provided.

It may be difficult to identify the important points in some illustrations without
a color copy of this booklet.  You can print or read this booklet in color from
MicroImages’ web site.  The web site is also your source of the newest tutorial
booklets on other topics.  You can download an installation guide, sample
data, and the latest version of TNTmips Free.

http://www.microimages.com

Merri P. Skrdla, Ph.D., 15 December 2011
© 2003–2011
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Welcome to TNTatlas
TNTatlas provides a means for limited or widespread
distribution of atlases.  The recipient of an atlas on
CD/DVD has everything required to view the atlas.
MicroImages requires no payment for the distribu-
tion of data and software in this fashion.  Once the
viewing software (TNTatlas) has been installed, it
can be used to view any atlas or object in TNTmips’
RVC format.  TNTatlas can also be run directly from
the CD/DVD that contains the atlas data.  Although
TNTmips is required to construct an atlas using
HyperIndex Linker, anyone using TNTmips, TNT-
edit, TNTview, or TNTatlas can access the atlases
created (depending on permissions).  Any of these
products, except TNTatlas, can be used to create a
single layout atlas.  Single layout atlases can be
viewed in all of the products including TNTatlas.

One example of widespread distribution of an atlas
is the street atlas of Istanbul on CD (in Turkish) in-
serted in a popular magazine with a distribution of
about 30,000.  The atlas was so popular that it was
also distributed with a second issue of the same
magazine.  Precision agriculture consulting provides
a good example of limited atlas distributions in
which only a single copy of an atlas is given out to
the individual farmer so that he or she may view all
the imagery, vectors, and other data collected for
the land they farm.  In either case, the recipient of
the atlas can be viewing the associated data within
minutes of inserting the CD/DVD in their computer.

Three additional booklets address different aspects
of working with atlases including assistance with
atlas design (Designing Electronic Atlases), atlas
assembly (Constructing an Electronic Atlas), and
the scope of projects that can be undertaken (MER-
LIN: Enterprise-wide Geospatial Analysis).  This
booklet is intended for people using TNTatlas who
were not involved in the design of the atlas and may
be unfamiliar with TNTmips.

STEPS

 copy the files in the
TNTATLAS data collection to
your local drive

The exercises on pages 4–
7 show you how to open an
atlas and navigate in a vari-
ety of ways.  Page 8 de-
scribes layer visibility, while
page 9 discusses viewing
attributes.  Page 10 demon-
strates web links by at-
tribute.  Page  11 provides
more tips for viewing single
layout atlases.  Pages 12–
14 describe customizing
your TNTatlas interface and
adding and using Macro
Scripts and Tool Scripts.
Pages 15–16 provide an
introduction to the features
of the GeoToolbox and re-
gions.  Page 18 discusses
using TNTatlas as a viewer
for files in other formats and
page 18 describes interface
features not already pre-
sented.  Page 19 describes
using multiple views in
TNTatlas.
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Launching a TNTatlas from CD/DVD
TNTatlas is used to refer to the program that runs
atlases constructed in TNTmips and to atlases that
are constructed in TNTmips.  Your most likely
source of the program and/or an atlas if you do not
run the professional TNT products is on CD or DVD.
The initial actions required when you insert a CD/
DVD that contains a TNTatlas depends on how the
atlas designer chose to set it up and whether
Autorun is enabled on your PC.  Autorun is never
enabled on the Mac.

The atlas may be set up to run directly from the
DVD or you may have to install the TNTatlas soft-
ware and choose to open the atlas that is also on

the DVD.  The person that created the atlas on DVD
also determines which platforms the atlas can run
on by what software they place on the DVD.  If you
acquire an atlas DVD that does not support your
platform, you can download TNTatlas for your plat-
form from MicroImages’ web site (www.
microimages.com/products/tntatlas/index.htm),
install from the downloaded file, and open the atlas
from the DVD regardless of the platform you are
running on.  TNTatlas uses the same data without
conversion on both Windows and Mac computers.

If the DVD you acquired supports running the atlas
without having to first install the software, it may
or may not also include the setup program for
TNTatlas and, if included, it is up to you whether
you want to install it.  Once the TNTatlas software
is installed, you can also use TNTatlas as a viewer
for individual objects in Project Files or files in a
variety of formats supported for direct use in the

TNT products (e.g. shapefiles, TIFF,
JPEG2000).  You can also use the TNTatlas
program that runs from the DVD for this pur-
pose.

TNTatlas can be used by
anyone with a Windows or
Mac computer and CD/DVD
drive.  You can substitute the
Internet (to download the
program and data) for a
DVD drive.

If TNTatlas is configured to
run directly from the DVD
and autorun is not enabled,
look for a batch file in the
root directory or a *.atl file in
the root or data directory.

If the atlas is configured to
autorun from the DVD and
autorun is enabled on your
machine, you will first see
the MicroImages splash
screen and then TNTatlas
will open.

double-
click
here to
run on
Mac

double-click here to run on
Windows
if autorun
is disabled

double-click on *.atl on Mac or Windows to run atlas from DVD
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STEPS

 install TNTatlas from
whatever source you
acquired it

 launch TNTatlas

 choose File / Open Atlas
from the TNTatlas win-
dow and select USA.ATL,
which is in the TNTATLAS

folder you copied

Installing and Opening

If the DVD does not autorun
and is configured to install
TNTatlas, look in the setup
folder and double-click on
setup.exe (Windows) or
*.dmg (Mac) to begin
TNTatlas installation.

If you have acquired an atlas on DVD that is not
configured to run directly from this medium, the
first step in running TNTatlas is to install it.  Placing
the disc in your DVD drive on a Windows machine
with autorun enabled should launch the installa-
tion program.  It could also launch an Adobe Acro-
bat or html document with buttons that let
you choose between installation and other
functions.

Installation is a simple procedure.  You just
read the screens that come up and click on the Next
or Continue button until you are done with
installation and you click Finish.  You do not
have to reboot your machine for installation
to be completed, as you do with many prod-
ucts.

During TNTatlas installation, an association
is established between the file, which has a
.atl extension, that specifies the atlas home
page and the program that launches TNTatlas so
that double clicking on any .atl file will open TNT-
atlas with the home page specified by that file.  You
can also launch TNTatlas by double-clicking on its
icon in the installed location or choosing it from
the MicroImages group on the Start menu (Windows
only).  If launched in this manner, you need to use
the File menu to open an atlas (.atl, Open Atlas) or
an object in RVC format or other formats supported
for direct display (Open Object).  If you received an
atlas on DVD, the .atl should be at the root level of
the disc or in the data directory.

You are instructed here to open an atlas that is pro-
vided as part of the sample data for the tutorial book-
lets.  You should, of course, also open the atlas that
came on your CD/DVD if that is how you acquired
TNTatlas.

When you open a TNTatlas,
you may initially get a blank
TNTatlas window or you
may get a window with an
introductory image until the
actual atlas data loads.
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TNTatlas Components
Like the TNTmips Display process, TNTatlas oper-
ates with view and manager windows.  Unlike Dis-
play, the Manager is optional in TNTatlas unless

HyperIndex Navigator

Navigate Back
Navigate Home

STEPS

 note that when you
pause the cursor over a
state, a DataTip with the
state name appears

 in the view window, click
on the HyperIndex /Set-
tings icon and choose
Show link aeas

 note the cursor changes
shape when over a link
area

 now toggle off the Show
link areas option

(continue to the exercise on
p. 11 without exiting.)

sidebar

you want to view at-
tribute tables.  The
three HyperIndex
icons at the right of
the toolbar appear
when the HyperIndex
Navigator tool is
toggled on.  Open the
Layer Manager from
the Options menu
(view window).

A HyperIndex stack,
or atlas, is a collection of
graphically and geographi-

cally related objects that uses the HyperIndex Navi-
gator tool for point and click retrieval of objects
from the hierarchical links established with Hyper-
Index Linker.  An atlas can also be a single layout
that uses map scale controlled visibility to reveal
and hide different layers as you zoom in and out.
In this case, you use the zoom tools, not the
HyperIndex navigation tool, to discover the breadth
of information presented in the atlas.

The area of the parent object that contains a link to
the next level in a stack is called a link area.  You
can choose to show or hide the outlines of these
areas.  If you click where link areas overlap, the

HyperIndex Link Selection win-
dow opens to let you choose
which link you want to follow.

The link areas in this example are
the min/max boxes for each state be-
cause the links were created automati-

cally using georeference information
rather than individually for each poly-
gon.

Choose Options/Layer Manager
if this window does not open.

HyperIndex
Settings
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Navigating Down
Many objects can be linked to the same parent ob-
ject.  In the atlas used for this exercise, the county
maps for each of the states have been linked to the
parent object (contiguous states of the USA).  When
you click on a state, its county map is displayed.  As
mentioned on the previous page, your links may
occupy the entire area represented by the min/max
box of the object you are linking to.  It may also be
an individual vector element, such as each state
polygon.  In this latter case, there is no area of over-
lap between link areas.  Note that the cursor shape
changes from the left arrow to a hand shape when
you are over a link area.

Clicking on the Navigate Home button always takes
you to the level of the atlas you started at.  The
Navigate Back button takes you one level up in the
hierarchy of the atlas to the layout that had the link
you used.  You have only navigated down one level
in this exercise, so the Navigate Back and Navigate
Home buttons will bring up the same object.

When you click on a location that is covered by
multiple link areas, a window opens that lists the
descriptions for all the link areas that overlap where
you clicked.  You then choose the link you want to
follow or cancel the navigation.  You can elect to
have this window open if there is just a single link
by turning on the Verify Selection toggle button on
the HyperIndex Settings menu from the correspond-
ing icon in the view window.  Generally, it is a nui-
sance to have to click [OK] each time you navigate,
but you may decide with some atlases, particularly
if you are not connected to the Internet (and the
atlas contains web links) or are running
on a slower machine, that you want to see
the description of the link before display-
ing the object.

Vocabulary: The Home
Level is the first level of a
stack.  In a published atlas,
the Home Level is often a
graphic that introduces the
purpose of the atlas.  You
can begin where you want
when viewing a stack in
TNTatlas by choosing Open
Object rather than Open
Atlas, which always opens
the Home Level when you
begin navigating.

STEPS

 with the HyperIndex
Navigator tool se-
lected

 click in the middle of
Nebraska

 pause the cursor over
several counties noting
the county names pro-
vided by DataTip

 right-click on the up-
and-left arrow,
note the choices,
and select one

 click on the Navi-
gate Home button
either in the HyperIndex
Navigator window or on
the view window toolbar

 click on the eastern bor-
der of Nebraska, then
choose Nebraska
county outlines from the
HyperIndex Link Selec-
tion window, and click
[OK]
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Layer Visibility
STEPS

 turn on link areas (see p.
6 if necessary)

 click on the link area in
Dawes county

 expand Group 1

 click on the Show / Hide
indicator for ROADS and
note the presence of the
new layer

 click on the Show
Zoom icon at the
bottom of the sidebar,
set Zoom to View Scale
and enter 42000 in the
scale field, and
press<enter>

 change the scale to
55000 and press
<enter>

Three conditions may cause a layer to not be cur-
rently visible: the Show / Hide indicator is set to
hide and/or the layer has map scale controlled vis-
ibility and the current scale is outside the visible

range and/or you are zoomed in such that the
entire layer is outside the extents of the cur-
rent view.  You can see if there are any hidden
layers by expanding the group it is in so the
layers are listed.  The Show / Hide checkbox

is immediately to the left of the layer
name.  Many atlases, particularly single

layout atlases, have so many lay-
ers that showing them all at once
is not practical.  The atlas de-
signer has to make the decision
about which layers to make vis-
ible initially.  If you are interested
in any of the other layers, you
can turn them on.

Map scale controlled visibility turns layers on and
off as you zoom in and out.  Low resolution images
can be replaced by higher resolution images as you
zoom in, or satellite imagery may replace a scanned

map.  Vector objects can show
different levels of detail.  With

map scale controlled visibility, a layer can always
be on, it can either appear or disappear when the
specified scale is reached, or it can be visible only
within a designated scale range.  The Zoom scale
field in the sidebar reports the number to the right
of the colon in the map scale at the bottom right of

the view (for example, 24,000 for
1:24,000).  To see the soil map in
this exercise, you have to zoom
in to 1:42,000 or greater.  You can-
not change the visible map scale
for  layers in TNTatlas.  Assigning
map scale controlled visibility is
also up to the atlas designer.
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Viewing Database Information
STEPS

 change the entry in the
scale field to 42000, and
press <enter>

 find the CBSOILS layer in
the TNTatlas Layer Man-
ager window, expand it,
then expand the poly-
gons

 click on the Show or
Hide Table checkbox for
the CLASS and YIELD tables

 click on the Select
icon button on the
view window toolbar

 click on a number of soil
polygons in the view
window noting the
records selected

 click on a Select
Record checkbox
in the YIELD table
then on the Exclu-
sive icon button in
the YIELD table’s toolbar
(note the view will pan if
the active element is not
visible)

 look at the polygon row
for CBSOILS in the TNT-
atlas Layer Manager
window and note how
many polygons are se-
lected

 repeat steps 6 and 7 for
a different soil type

 click on the Hyper-
Index Navigator tool

TNTatlas provides you the same access to database
information available in TNTmips.  You can view
attributes of selected elements and use attributes to
select elements.  You can use attributes to select
elements while the HyperIndex Navigator tool is
active, but you must switch to the Select tool or the
GeoToolbox to select elements with the mouse.

The Select tool on the view window toolbar lets
you select individual elements.  In addition to in-
dividual element selection, the GeoToolbox lets
you draw geometric and irregular shapes for use in
selection.  You can make measurements using these
same shapes or create a sketch layer or region from
them (these features are described in the Sketching
and Measuring and Interac-
tive Region Analysis book-
lets).

If you select elements with-
out first opening a database
table, the first table associ-
ated with the element type
selected opens automati-
cally.  For many vector
objects, this table may be
the element ID table,
which is not likely to pro-
vide information of inter-
est to you.  You need to
take the positive actions described in this exercise
to open the table you want to view.  Unless you are
already familiar with the data in the atlas you are
viewing, finding the information you want to see is
an exploration process.  You show details on groups
and layers, then reveal the list of tables and decide
which to open.
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Web Links By Attribute
Point-and-click object retrieval in TNTatlas replaces
the current view window contents with the object
retrieved.  Any object type, including complex lay-
outs that include many different objects and scale
bars, legends, or other enhancements, can be re-
trieved as was demonstrated in the previous two
exercises.  When the link is to an external file type
that is not supported for direct display or to a web

site, a sepa-
rate window
opens for
that applica-
tion, and the
current view
remains un-
changed.

The layout
for this exer-
cise shows a

resampled mosaic of Digital Ortho Quarter Quads
(DOQQs) for a portion of Box Butte County as the
base for a sample of registered ground water wells
in the area.  The well points are theme mapped by
pumping capacity.  Each of the points has a link to
the groundwater wells data maintained by the Ne-

braska Department of Natural Resources
(NDNR).  This link used to take you di-

rectly to the informa-
tion for the well you
clicked on.  Changes
in the NDNR web site
now require you to
choose what informa-
tion you want to enter
and that you then en-
ter that information in
order to view their in-
formation for a par-
ticular well.

STEPS

 click on the Navigate
Back icon then on
the other link area (in
Box Butte County)

 make sure you are con-
figured to connect to the
Internet although you
need not have launched
your browser

 with the
Hyper-
Index
Navigator
tool still
selected,
click on
one of the
points

 un-check
Owner’s
Name and
check
Registra-
tion Number, then click
Submit

 hover over the point you
clicked on and enter the
number shown in the
DataTip, then click Sub-
mit
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Viewing Single Layout Atlases
The HyperIndex Navigator tool has no function with
single layout atlases unless there are links to web
sites or other file types.  You reveal the depths of the
atlas with the zoom and pan tools.  The hot keys
presented at the bottom of the page 18 are also use-
ful.  Single layout atlases rarely have all the layers
shown at one time.  The earlier exercise on Layer
Visibility describes different methods of making lay-
ers draw without specifically using the zoom box.

The Zoom Box is used to select an area you want to
zoom up on and is proportional to your view area
(unless you have differential zooming turned on).
There is an Options / View Settings toggle that lets
you set whether the tool is spring loaded (zooms
when you release the mouse) or right-mouse button
activated.  In the latter case, the Zoom Box remains
on the original image where it was drawn, so that its
position and size can be adjusted, until you click
the right mouse button.  Set this toggle in which-
ever position you prefer.

Most single layout at-
lases are far more com-
plex than the layout used
in this exercise, which
you should recognize as
part of the larger USA at-
las.  This layout, however,
will serve to demonstrate
approaches to use with
single layout atlases.  If
you see a layer listed that you want to view but you
don’t think it is drawn, first check if it is hidden.  If
not, try zooming to the layer extents.  If the layer
has map scale controlled visibility, it may be vis-
ible at this scale.  If the layer has been assembled
from many pieces, for example all the TIGER data
in the state, it will not likely be visible when you
zoom to its extents so zoom in within the extents.
Finding a layer of interest may take some thought.

STEPS

 choose File / Open Ob-
ject and select SPOTAND

OVERLAYS from the CB_SPOT

Project File

 click on the Zoom
Box tool, position
the cursor at the upper
left of the raster, draw
out a box that encom-
passes at least two grid
squares in each direc-
tion, then release the
mouse (right click if
needed)

 click on the Full
icon button

 choose Options / View
Settings and toggle on
the last button (Use right
mouse button to perform
zoom or pan)

 repeat step 2 except
reposition and resize the
box after its initial draw-
ing, then click the right
mouse button

 click on the Zoom to
Active Group icon
in the view window

 expand Group 1 in the
Legend, right-click on
SPOT_PAN in the Layer
Manager and choose
Zoom to Extents
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Synchronize Atlas View with Google Earth
STEPS

 connect to the Internet

 click on the Syn-
chronize External
GeoViewer icon

 turn on the Google
Earth toggle

 turn on the Draw View
Extents as Temporary
Place option in the
Google Earth Synchroni-
zation window

The outline shown in Google
Earth indicates the area shown
in your TNTatlas view window.

You can open a view that includes the extents of
your current TNTatlas view in Google Maps, Micro-

soft Bing Maps, or Google Earth.  For
the first two choices, you need to
reselect synchronization from the icon
again to update position and zoom

changes.  Google Earth will automatically follow
these changes but will ask if you want to reload the
KML file generated by TNT, which indicates your
new location and/or zoom level.  You can turn this
prompting off by clicking on the Always button.

Google Earth synchroniza-
tion provides additional op-
tions to show the
centerpoint of your view,
show view and group out-
lines, and/or to change the
relative zoom from your
view to that shown in
Google Earth.  Google Maps
also shows the center point
of your view.



page 13

Using TNTatlas

Another option available to the atlas designer is
customizing the interface to provide only the tools
he or she thinks you will need.  Thus, it is possible
that you may have received an atlas that does not
have all the buttons illustrated on the preceding
pages.  The atlas designer also controls whether or
not you can customize the inter-
face.  The Hidden Features choice
on the Options menu presents all
available icon buttons and menu
choices.  Not all choices are on
by default.  If you are using
TNTatlas downloaded from
MicroImages’ web site, you will
have the ability to customize the interface.  The
features you select are part of the TNTatlas program,
not the atlas itself and will be retained if you run the
same program and open a different atlas.

TNTmips’ display process, which is incorporated in
TNTatlas, has many tools and features that the nov-
ice or casual TNTatlas user will not utilize.  Such
features may have been removed from the interface
to simplify its use or you can remove the tools and
options you do not use if customization is allowed.

The Customize window is divided into Toolbar and
Menubar sections.  All toolbar icons are listed be-
fore the menubar selections.  All user interface
customization settings are stored in the customui.usr
file.  These settings can be transferred to subsequent
installations of the TNT products if you choose the
transfer settings option during installation.

STEPS

 choose Options / Hidden
Features in the view
window

 scroll through the
choices noting what is
on and what is off

 make any changes de-
sired

The toolbar shown above is the default configuration.
The toolbar below has all available icons turned on.

These are the
atlas specific
navigation icons

Drawing Actions
View Actions

Tool Selection

Customization of TNTatlas Interface

All View menu choices are
shown above.  All choices
that have corresponding
icons have been removed
from the View menu below.

Marking Modes
Marking Actions
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Adding and Using Custom Tools
In addition to adding and removing menu items
and icons, you can add specific functionality to
your atlas, or it may have been added by your atlas’s
designer.  If Macro or Tool Scripts were added by
your atlas’s designer, they will come and go as you

Navigate through the
atlas (unless it is a
single layout atlas) be-
cause they are associ-
ated with specific lay-
outs.  Look for icons to
appear to the left of the
HyperIndex Settings
icon.

Macro and Tool Scripts that you add will only be
available in the current TNTatlas session if you are
running from DVD.  If you have installed TNTatlas,
these scripts will be available the next time you
open TNTatlas provided you did not choose the
This layout only option in the Script Properties win-
dow.

STEPS

 with the SPOTAND

OVERLAYS layout open,
choose Options / Macro
Scripts (View window)

 click on the Add icon
and select ZOOMTO.SML

 enter Zoom to Scale in
the Name field

 click in the Menu
Choices text box and
type in the entries
shown, then click [OK] in
both windows

 click on the new icon to
the left of the
HyperIndex Settings
icon on the toolbar
and select 60000

 click on the same
icon and select 42000,
then note the difference
in scale and what is dis-
played

Note: Some Macro and
Tool Scripts only make
sense for a particular
layout in an atlas, such
as the script added
here.  If you zoomed to
either of these scales at
the USA or Nebraska
level, you would likely
see nothing but your
background color.

Macro Script used to
zoom to 1:42,000 and
CBSOILS is displayed.

Macro and Tool Script
icons will appear here.

Macro Script used to
zoom to 1:60,000 and
CBSOILS is not displayed.
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Introduction to the GeoToolbox
The GeoToolbox integrates sketching, measuring,
selection, and region operations.  Input for any of
these functions can come from the mouse, an X-Y
digitizer, or a GPS unit or log.  You can get the mea-
surements for a polygon you draw as a region then
add it to a sketch just by switching tabbed panels in
the GeoToolbox and using the right mouse button
menu.  Elements added to sketches can have at-
tributes and you will be prompted for the attribute
value for each element you add if you choose to use
attributes.  A simple Select tool is provided on the
View window toolbar, but the GeoToolbox provides
area selection as well as single element selection.  A
simple Annotate tool is also provided on the View
window toolbar.

There are two line drawing modes that
are used with the line and polygon
tools: draw and stretch.  In the draw
mode, the line is drawn as you drag the
mouse.  In the stretch mode, the line
can be adjusted as you drag the mouse
and the next vertex is added where you release the
mouse button.  Your preference for drawing is set on
the Controls tabbed panel.  The Ruler tool behaves
like drawing a line in stretch mode.

STEPS

 with the SPOTAND OVER-
LAYS layout open, zoom
back to 1:60,000

 click on the Geo-
Toolbox icon

 click on the Ruler
icon

 click on one of the dot-
ted lines, then hold and
drag to an adjacent dot-
ted line

 click on the Measure tab
and see how close to 1
mile you got (change
units from the Options
menu in the
GeoToolbox)

 right click over the im-
age and note the avail-
able choices (the middle
panel tells you the kinds
of regions you can gen-
erate from the line
drawn)

Keep this layout open
through the exercise on
page 17.
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Making a Buffer Zone Region
STEPS

 expand the HYDROLOGY

layer in Group 1 (Layer
Manager) and turn on
selection for lines by
clicking on the
arrow

 draw a rect-
angle that
contains a few of
the hydrology
lines, then right-
click and choose
Select Elements

 right-click on the
lines row in the
Layer Manager, and
choose Buffer Zone
Region

 click on Apply to see a
preview of the buffer
zone  region at the
default width

 change the buffer
zone width to 200
meters, and click
Apply again

 click on OK

 switch to the Re-
gion tabbed panel
in the Geo-
Toolbox and note
that the region
generated is
named the same
as the object it was gen-
erated from and it is
once again shown in the
TNTatlas window

 click on Group 1 in the
Layer Manager to make
it the active group then
click on the Sketch tab
and try your hand at
sketching

You have the option of generating regions from
shapes you draw or from selected elements.  When
you right-click over the image in the TNTatlas win-
dow in this exercise, the region is generated for the
element you have drawn using the GeoToolbox.  In

this case, right-
clicking over
the image after
you have se-
lected the ele-
ments and
c h o o s i n g
Buffer Zone
Region would
buffer around

the rectangle you drew
rather than around the se-
lected elements.  The region
options are not on the right
mouse button menu for an

element type
unless you
have selected
elements of
that type in
that layer.

The GeoTool-
box provides
many addi-
tional power-

ful tools for your use.  You should take the time to
discover more of its functionality.  For more infor-
mation on the GeoToolbox, consult the Sketching
and Measuring and Interactive Region Analysis
booklets.
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Using TNTatlas as a Viewer
STEPS

 choose File / Open Ob-
ject

 select any TIFF, JP2,
MrSID, ECW, shapefile,
or TAB file you have*

 if you do not have data in
any of these file formats,

choose a TIFF file from
the  import folder with the
data on a TNT products
DVD or from Micro-
Images’ web site.

* See the Tech Guide en-
titled System: Direct Use
of Geodata Files for ad-
ditional formats

Although TNTatlas is much more than a viewer, it
can be used to view data in a variety of formats in
addition to the TNT products Project File format.
You can directly view rasters in TIFF/GeoTIFF, JP2,
MrSID, and ECW (Enhanced Compressed Wavelet
from ER Mapper) formats.  You can also directly
display data in ESRI’s shapefile format and
MapInfo’s TAB format.  Shapefiles are dis-
played as shape objects and TAB files as CAD
objects.  A number of other formats are also
supported for direct display*.  You can even
display an Oracle Spatial  layer in TNTatlas if
someone had previously created a link to the
layer in
TNTmips,
TNTedit, or
TNTview.

TIFF

You can view any of the supported
formats using the same methods
you use to open a single layout atlas
or any other object in MicroImages’
Project File format.

JP2

shapefile

TAB
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TNTatlas Miscellaneous Features
STEPS

 choose File /
Open Object and
select
WELLS_AND_DOQQ
from the  WELLS

Project File

 click on the + to
the left of Group 1
in the Legend

 note the appear-
ance of the layer
names and their
legends

 click on the minus
(-) to the left of the
MOSAICCOQ layer name
(note that only the legend
for that layer is hidden)

 right click on the wells
layer name in the Legend
and choose View
Metadata

 read the metadata, then
choose File / Close in the
Metadata Viewer window

 move the cursor to
the right of the vertical
scroll bar in the Leg-
end, but not over the
view itself; the cursor
should become a
double-arrow, then click
and drag to resize the
Legend

 choose View Histogram
from the RMBM for the
MOSAICCOQ layer, and
note the information
presented

 try other selections
on the RMBM

The sidebar appears at the
left of the view window and
can be turned on/off and
resized.  The gadgets for the
sidebar are controlled by the

icons near the bottom.  The information in the
Legend can be expanded and collapsed.  It is a
matter of personal preference whether you want
the legend information in the view window or
you want the Layer Manager or neither.  How-
ever, you need the Layer Manager window to
view dabase information.

You will find a variety of right mouse button func-
tions at the group and layer levels in the Legend.
Clicking the right mouse button on the group name
lets you choose to open the group settings, hide/
show layers in the main and locator view, and zoom
to extents among many other functions.  The right
mouse button menu (RMBM) for the layers lets you
zoom to various levels of detail, and open the Mark
by Query window.  These functions and more are
available from the RMBM for each layer in the

TNTatlas Layer Manager including
the options to view raster histograms,
layer extents, metadata, and to turn
DataTips on/off if they have been set
up by the designer.  For vector, shape,

CAD, and TIN layers you can also zoom to the ac-
tive or selected elements.

A number of hot keys are available to make chang-
ing view position and zoom easier.  The view win-

dow must have focus for these
to be active: redraw at full
view, 0; set zoom to 1X–4X,
1–4; recenter at cursor loca-
tion <space>, zoom in, +;
zoom out, -.

These icons control show/hide
for the sidebar features.

Legend

SidebarMagnifier

LocatorPlaces

Zoom

*

* See the collection of
2012 Technical Guides
about the Sidebar and
its functions.
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Multiple Views
The designer of an atlas you have acquired may
have set the atlas to open with multiple views of the
same data open.  You can also choose to open addi-
tional views of any atlas.  Once you have multiple
views open, you can turn on/off different layers and/
or groups in the layout in different view windows.
You can also display different views at different
scales.

You may want to consider using the GeoLock fea-
ture if you have multiple views open.  This feature
lets you move the view in all of the open windows
by changing the position and or the zoom in any
one of the windows.  The position of the cursor in
any one of the windows is also shown in the others
by a yellow crosshair.  The icon for GeoLocking is
one of the hidden features in TNTatlas (see p. 13)
but can also be turned on using the GeoLock toggle
on the View menu.  You set whether you want to use
relative zoom or extents or both to determine how
other views are adjusted by choosing GeoLock Set-
tings from the Options menu.  When you are work-
ing with multiple views you may also want to use
the Multi-View Locator.  See the Technical Guides
entitled Geolock with Relative Zoom
and Multi-View Locator Tool for more
information.

STEPS

 choose View/Open Addi-
tional in the TNTatlas
View window

 check that GeoLock is
toggled on on both View
menus

 turn different layers on/
off for different views
and compare them

 open Geolock Settings
(Options/GeoLock Set-
tings), change the Rela-
tive Scale to 5, click OK
then Refresh

Right-click on a Show/Hide
checkbox to see which views
a group or layer is visible in
and to make changes.

No check indicates that the
group/layer is hidden in all
views.

A gray check indicates that
a group or layer is hidden in
one or more views.

A black check indicates
that a group or layer is
visible in all views.
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